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| Voorwoord | 

             

Door bezig te zijn in de praktijk, merkte ik waar mijn hart ligt. In de laatste paar maanden van mijn 

studie Toegepaste Psychologie ben ik te werk gegaan als onderzoeker voor Philips Healthcare. Dit 

deed ik samen met twee andere studenten. Ieder had zijn eigen te onderzoeken gebied overkoepelt in 

één geheel: het Ambient Scent onderzoek. Onder andere vanwege de experimentele aard en het 

interdisciplinaire karakter was dit onderzoek een uitdaging voor mij en erg interessant om uit te 

voeren.  

De voorbereiding die aan het onderzoek vooraf gingen, bestonden uit een creatief proces waarin vaak 

zaken werden afgewogen en verworpen om zo uiteindelijk het onderzoek steeds concreter vorm te 

kunnen geven. Ook de uitvoering van het onderzoek leverde mij veel ervaring op en bracht mij punten 

op waar ik nog meer over wil leren en technieken die ik onder de knie wil krijgen. Met andere woorden: 

dit is waar ik verder in wil doorgroeien en later mijn beroep van wil maken.    

Ik wil dan ook mijn afstudeerdocente Marijke Bergman, mijn voormalige onderzoeksbegeleider Gijs 

van Elswijk als ook mijn huidige onderzoeksbegeleider Björn Vlaskamp bedanken voor de goede 

begeleiding en samenwerking. Daarnaast wil ik ook mijn mede onderzoeksstudenten Eric van 

Denderen en Ank van de Veer bedanken voor de fijne en leuke samenwerking.  

 

Niels Janssen 

Echt, mei 2012 
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| Samenvatting | 

             

Het doel van dit onderzoek was om te kijken naar de bijdrage van geur op de duur van visuele 

aandacht en de waardering op de visuele stimuli. 34 studenten met een gemiddelde leeftijd van 21 

jaar deden mee als proefpersoon en werden ingedeeld in twee groepen. Deze twee groepen 

bestonden uit een geen geur controle groep en een geur experimentele groep. Iedere proefpersoon 

kreeg een video te zien en vulde daarna een vragenlijst in. In deze vragenlijsten werd gevraagd naar 

de waardering en de mate van aandacht tijdens het kijken naar de video. De scores op deze twee 

variabelen werden vergeleken met de twee groepen door middel van twee Mann- Whitney U toetsen. 

Uit de resultaten kwam naar voren dat er geen significant verschil aangetoond kon worden en geur 

dus op geen van beide variabelen bijdroeg. Als aanvullende analyse werd een Spearman’s Rho 

uitgevoerd om te kijken naar een mate van samenhang tussen waardering en visuele aandacht. De 

Spearman’s Rho liet geen correlatie zien tussen beide variabelen. Gezien uit dit onderzoek geen 

effecten konden worden aangetoond geeft dit aanleiding tot vervolgonderzoek.  

 

| Abstract | 

             

The purpose of this study was to investigate the contribution of odor at the durance of visual attention 

and the appreciation of visual stimuli. 34 students with a mean age of 21 participated as a subject and 

were classified into two groups. These two groups concluded a no odor control group and an odor 

experimental group. Each subject had to watch a video and completed a questionnaire. This 

questionnaire contained questions about appreciation and a degree of attention towards the video. 

The scores obtained on these two variables were compared with the two groups through two Mann- 

Whitney U tests. The results showed that there wasn’t a significant difference which means odor didn’t 

contribute on any of these variables. As an additional analyze a Spearman’s Rho was performed to 

see if there was a relation between the variable visual attention and appreciation. The Spearman’s 

Rho showed no correlation between these two variables. Considering the fact this study didn’t show 

any effects, this provokes further extensive research.   
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Hoofdstuk 1 | Inleiding | 

             

1.1.1 Aanleiding voor dit onderzoek 

Angst is één van de meest voorkomende problemen voor een operatie (Fayazi, Babashahi & Rezaei, 

2011) als ook bij het ondergaan van MRI scans (Harris, Cumming & Menzies, 2004). De 

psychologische ongemakken die mensen ervaren bij het ondergaan van MRI scans kunnen het 

maken van beelden hinderen (Brennan et al., 1988), bijdragen aan weigering van het ondergaan van 

verdere scans (Koechling, Spevack, Gerstein, Del Vasto, & Del Carpio, 1996), het ontwikkelen van 

claustrofobie (Fishbain et al., 1988) en het ontwikkelen van paniek aanvallen (Koechling et al., 1996).  

 

Gezondheids instellingen worden steeds meer als aanbieder van gehele zorg voor patiënten 

beschouwd (Drahota, Stores, Ward, Galloway, Higgins & Dean, 2004) en brengen producten op de 

markt om pijn en angst te reduceren bij de patiënten (Drahota, Galloway, Stores, Ward, Severs & 

Dean, 2008).  

 

1.1.2 Philips Healthcare en de Ambient Experience 

Philips Healthcare richt zich op het oplossen en ontwikkelen van de behoeften van zorgteams en 

patiënten. Het creëren van een optimale omgeving voor zowel patiënt als medewerker wordt dan ook 

als uitgangspunt gezien. De Ambient Experience is ontwikkeld door Philips Healthcare en is speciaal 

ontworpen om in te spelen op de gemoedstoestand van de patiënt en daarmee angstreductie te 

bewerkstelligen. Naast angstreductie is de Ambient Experience ook ontworpen om de werkstroom bij 

het personeel te verbeteren (Philips Healthcare, 2012).  

Tot nu toe bestaat de Ambient Experience uit audiovisuele afleiding waarbij een patiënt die een scan 

ondergaat een video kan kiezen. Deze video wordt begeleidt door een rustgevend geluid. Een zintuig 

dat nog niet onderzocht is, is het reukorgaan. Uit meerdere onderzoeken blijkt geur een 

angstreducerend effect te hebben (Saeki & Mayumi, 2001). Zo bleek uit een onderzoek naar patiënten 

die een MRI scan ondergingen dat de patiënten na blootstelling van een vanilleachtige geur een 

mindere mate van angst vertoonden (Redd. Et al., 1994). 
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1.1.3 Relevantie 

De vraag vanuit Philips Healthcare is dan ook om de invloed van geur op de beleving te onderzoeken 

en te kijken naar een mogelijke toepassing van geur in de Ambient Experience. Voor Philips 

Healthcare is het relevant om het reukzintuig te hebben onderzocht om het ontworpen Ambient 

Experience eventueel uit te kunnen breiden met het gebruik van geur. Angst kan namelijk onder 

andere de kwaliteit en bruikbaarheid van MRI scans verslechteren (Murphy & Brunberg, 1997). Geur 

laat positieve effecten op angstreductie zien uit eerdere onderzoeken. Indien geur uiteindelijk in 

combinatie met beeld en geluid de angstreductie nog sterker kan bewerkstellingen is dit een voordeel 

voor de maatschappij, Philips Healthcare en de patiënt zelf. Dit zorgt uiteindelijk voor een beter welzijn 

voor de patiënt als ook een verbeterde werkstroom voor bijvoorbeeld het personeel in een ziekenhuis, 

wat aansluit op de uitgangspunten van Philips Healthcare.  

 

1.1.4 Doelstelling 

 

Vanuit de vraag van Philips Healthcare is de volgende doelstelling tot stand gekomen:  

 

Inzicht verkrijgen in hoeverre geur een bijdrage levert op de duur van visuele aandacht en de 

waardering van visuele stimuli, ten einde een advies te kunnen opmaken over verdere 

toepassingen van geur binnen de Ambient Experience. Dit om in de toekomst verdere 

angstreductie te bewerkstelligen en de patiënt een verbeterde mate van welzijn hiermee te 

geven.  

 

1.1.5 Hoofdvragen 

 

Vanuit deze doelstelling zijn er twee volgende hoofdvragen opgesteld. Deze luiden als volgt: 

In hoeverre draagt geur bij aan het vasthouden van visuele aandacht? 

In hoeverre draagt geur bij aan de waardering van visuele stimuli? 
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1.1.6 Onderzoeksvragen 

 

Deze hoofdvragen worden in het veldonderzoek verder onderzocht. In het literatuur onderzoek zijn 

alvorens in te gaan op de hoofdvragen, onderzoeksvragen opgesteld om een overzicht te verkrijgen 

wat al bekend is uit eerdere onderzoeken. Deze onderzoeksvragen luiden als volgt: 

Hoe werkt het reukorgaan en hoe wordt geur waargenomen? 

  

Welke effecten kan geur teweeg brengen? 

 

Wat is visuele aandacht en heeft geur hier effect op? 

 Heeft geur effect op de waardering voor andere stimuli? 

 

In hoofdstuk twee worden deze onderzoeksvragen beantwoordt met wat al bekend is uit eerdere 

onderzoeken. Hierin staan de begrippen geur, visuele aandacht en waardering centraal. Verdere 

begrippen die in het literatuur onderzoek voorkomen zijn terug te vinden in de begrippenlijst. Deze 

begrippenlijst is als bijlage bijgevoegd. Het literatuur onderzoek wordt afgesloten met een conclusie uit 

de gevonden literatuur. In hoofdstuk drie wordt beschreven hoe het veldonderzoek heeft plaats 

gevonden en welke resultaten daaruit voortkwamen. Op basis van deze resultaten wordt een 

conclusie getrokken en worden daarbij discussiepunten benoemd. Als laatste worden aan de hand 

van deze discussiepunten aanbevelingen voor verder onderzoek gedaan. 
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Hoofdstuk 2 | Literatuur onderzoek | 

             

Geur, in vergelijking met het visuele zintuig en gehoor wordt door de mens vaak als een minder 

belangrijk zintuig gezien (Coren, Ward & Enns, 2004). Om objecten te herkennen gebruikt de mens 

als eerste het visuele systeem en pas na het ontstaan van aandacht voor een object worden de 

andere zintuiglijke karakteristieken als bijvoorbeeld geur vastgesteld (Sakai, Imada, Saito, 

Kobayakawa, & Deguchi, 2005). De waarneming van geur gebeurt veelal op onbewust niveau en 

speelt een veel grotere rol als vaak gedacht wordt (Coren et al., 2004). Geur heeft namelijk onder 

andere een grote invloed op emoties, cognitief functioneren en het geheugen (Herz, 2009). Daarnaast 

werkt geur samen met smaak en helpt het de mens om voedsel beter te kunnen identificeren (Coren 

et al., 2004).    

 

2.1.1 Geur en beleving 

Het reukorgaan kan door directe toegang tot het limbische systeem menselijke emoties raken (Goel & 

Grasso, 2004) en heeft daarmee invloed op de gemoedstoestand (Herz, 2009). Geur wordt om deze 

reden dan ook toegepast in aromatherapie. Aromatherapie kan omschreven worden als het gebruik 

van oliën verkregen uit aromatische planten voor medische doelinden en werd al duizenden jaren 

geleden gebruikt in India en Egypte als geneesmiddel tegen verschillende ziektes (Fayazi et al., 

2011). Er is al veel onderzoek gedaan naar effecten van aromatherapie. Zo is onderzocht dat 

aromatherapie een angstreducerend effect heeft (Saeki & Mayumi, 2001). Zo toonden Lehrner, 

Marwinski, Lehr, Johren & Deecke (2005) aan dat patiënten die blootgesteld waren aan sinaasappel 

of lavendel geur, verminderde angst hadden, een verbeterde gemoedstoestand hadden en een 

verhoogde mate van rust hadden, vergeleken met patiënten in de controle conditie. Geuren als 

sinaasappel en lavendel laten ook een significante toename in positieve stemming zien onder mensen 

die een stressvolle gebeurtenis ondergaan (Lehrner, Eckersberger, Walla, Pötsch & Deecke, 2000). 

Daarnaast wordt aromatherapie met lavendel gezien als een psychisch rustgevende therapie (Shiina 

et al., 2008). 

Naast bovenstaande effecten op de gemoedstoestand kunnen geuren sterke en aanhoudende 

aangenaamheid produceren en kan dit tevens bijdragen aan de beoordeling van andere stimuli 

(Grabenhorst, Rolls & Margot, 2010).  
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2.1.2 Hedonische waarde 

Het prettig vinden van een geur is gerelateerd aan de gemoedsverandering die daardoor ontstaat. Als 

een persoon niet van een bepaalde geur houdt zal deze ook niet als rustgevend werken (Herz, 2009). 

Dit prettig of onprettig vinden van een geur heeft te maken met de hedonische waarde. Burnett, 

Solterbeck & Strapp (2004) lieten in hun onderzoek zien dat proefpersonen die geen verwachte 

hedonische respons lieten zien ook geen gemoeds- of gedragsverandering ervoeren.  

Er zijn meerdere factoren van invloed op de hedonische waardering. Zo spelen overtuigingen over 

gezondheids eigenschapen van een geur (Dalton, Wysocki, Brody & Lawley, 1997), de overtuigingen 

over de herkomst van een geur (Distel & Hudson, 2001; Herz, 2003) en de emotionele waarde over de 

situatie waarin de geur wordt ervaren (Epple & Herz, 1999; Kirk-Smith, Van Toller & Dodd, 1983) een 

rol in de waardering voor geur. In vele gevallen leert de mens van geuren te houden door associaties 

met aangename of onaangename ervaringen (De Houwer, Thomas & Baeyens, 2001) en maakt dat 

geur een relatie heeft met het geheugen. 

 

2.1.3 Geur en het geheugen 

Geur is in vergelijking met de andere zintuiglijke waarnemingen namelijk uniek in de relatie met het 

geheugen (Stafford, Salehi & Waller, 2009). Reuk stimuli vormen krachtigere aanwijzingen voor 

autobiografische herinneringen dan stimuli die door andere zintuigen zijn gepresenteerd (Chu & 

Downes, 2000) en zijn vaak emotioneler geladen (Herz & Cupnik, 1995). Twee synapsen scheiden de 

olfactorische zenuw (Eichenbaum, 2001), welke gevormd wordt door de olfactorische receptor cellen, 

(Coren & Ward, 2004) van de amygdala. De amygdala is belangrijk voor de uitdrukking en ervaring 

van emoties en emotionele herinneringen.  

Als voorbeeld kan hier gedacht worden aan het Proust fenomeen waarin Marcel Proust een koekje in 

de thee dipt en door de aroma terugdenkt aan zijn jeugd (Doop, Mohr, Folley, Brewer & Park, 2009). 

Dit komt onder andere doordat herinneringen voor geur niet snel vervagen (Engen & Ross, 1973) en 

geuren ook oudere herinneringen kunnen ophalen (Rubin , Groth & Goldsmith., 1984). Om een 

stimulus te kunnen ophalen moet het eerst deel uit maken van het geheugen (Chu & Downes, 2002). 

Het geheugen kan daarnaast als bindend middel werken om stukken uit het verleden in een Gestalt te 

vormen zodat het verleden kan worden herbeleefd in het hier en nu (Doop  et al., 2009). 
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2.1.4 Geurwaarneming en het reukorgaan 

 

Voor de waarneming van geur is het olfactorische systeem verantwoordelijk. Dit olfactorische systeem 

bestaat uit een zintuiglijk orgaan, het olfactorische epitheel, en specifieke olfactorische 

hersengebieden (Mackay-Sim & Royet, 2012). Een geur die aankomt in de neus maakt contact met de 

olfactorische receptor cellen. Deze olfactorische receptor cellen zijn gelegen in het olfactorische 

epitheel (Buck, 2004). Doordat de geuren in contact komen met de olfactorische receptor, ontstaat er 

transductie. Hierbij ontstaan elektrische signalen in de sensorische zenuwen naar de bulbus 

olfactorius en deze zendt signalen naar een aantal andere plaatsen in de cerebrale cortex waaronder 

de piriforme cortex (Goldstein, 2007). Deze piriforme cortex is een belangrijk deel van de reukzin en is 

betrokken bij het herkennen van geuren (Dade, Zatorre & Jones-Gotman, 2002). 

Geur waarneming ontstaat sneller en is meer accuraat als deze met congruente visuele stimuli wordt 

gepresenteerd. Hierbij vindt activiteit plaats in het voorste gedeelte van de hippocampus en de 

orbifrontale cortex (Gottfried & Dolan, 2003). Deze activering van de hippocampus en orbifrontale 

cortex suggereren dat er interactie bestaat tussen het olfactorische- en het visuele systeem (Gottfried 

& Dolan, 2003).  

Dat het visuele systeem ook betrokken is bij het identificeren van geuren, blijkt onder andere uit een 

onderzoek van Blackwell (1995). Blackwell (1995) ontdekte dat proefpersonen de smaak van 

sinaasappel als limoen identificeerden als deze groen gekleurd was. Ook hiervoor kan een reden 

gevonden worden in de interactie tussen beide zintuigen, waarbij in dit geval associaties gemaakt 

worden tussen het olfactorische- en visuele systeem (Sakai et al., 2005).  

 

2.1.5 Geur en visuele aandacht 

Het kunnen zien maakt het mogelijk om onderdelen en structuren in de omgeving te kunnen 

vasthouden door het selecteren van opvallende of relevante informatie (Jacquot et al., 2005). 

Het visuele systeem kent echter een capaciteitsgrens en de hersenen kunnen niet alle externe stimuli 

waarnemen en verwerken (Solso, Maclin & Maclin, 2008). Om deze reden wordt er een selectie 

gemaakt uit de externe stimuli (Brysbaert, 2006). Het mechanisme van het zenuwstelsel om bepaalde 

gebieden, objecten of kenmerken te benadrukken binnen het visuele systeem, wordt visuele aandacht 

genoemd (Bisley, 2011). Hoewel de mens er zich niet altijd bewust van is, is visuele aandacht 

belangrijk voor de perceptie, het leren, het geheugen en de interactie met de visuele wereld (Bisley, 

2011).  

Zoals eerder benoemd bestaat er interactie tussen het olfactorische- en het visuele systeem. Knasko 

(1995) toonde aan dat proefpersonen langer naar een plaatje keken in de aanwezigheid van een 

aangename geur als babypoeder of chocolade, vergeleken met proefpersonen die geen geur kregen 

toegediend. Jacquot, Millot en Brand (2005) toonden aan dat geur invloed heeft op zowel de 
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amplitude als de tijdsduur van visuele aandacht, maar daarnaast ook invloed heeft op de snelheid van 

informatie verwerking. Warm, Dember en Parasuraman (1991) gaven in hun onderzoek aan dat onder 

andere de geur van pepermunt de prestatie verhoogt op een visuele aandacht taak. Geur kan de 

aandacht bij congruente beelden doen versterken (Seo, Roidl, Müller & Negoisas, 2010) en kan 

daarnaast zorgen voor een toename in intensiteit en aangenaamheid van een geur indien er 

congruentie bestaat tussen geur en beeld (Sakai et al., 2005).  

Hoewel uit onderzoek naar voren komt dat geur de aandacht bij congruente beelden doet versterken, 

blijkt uit onderzoek van Barcelo, Gale en Hall (1995) dat blootstelling aan aangename en rustgevende 

geuren geassocieerd wordt met een significante vermindering van EEG theta activiteit, een frequentie 

die aandacht weerspiegelt. Lavendel geur laat uit onderzoek zien een rustgevende werking te hebben 

(Herz, 2009). Rustgevende en aangename geuren kunnen daarom als afleidend werken, of aandacht 

verminderen (Gould & Martin, 2001). Moss, Cook, Wesnes en Duckett (2003) onderzochten de invloed 

van lavendel geur en rozemarijn op geheugentaken en aandacht en concludeerden dat lavendel geur 

het geheugen en de aandacht aantaste en dat rozemarijn juist het lange termijn geheugen bleek te 

verbeteren.         

 

2.1.6 De Gestalt theorie: de ervaring van het geheel 

Volgens de Gestalt theorie bestaat waarneming niet uit een reeks onafhankelijke sensaties, maar 

nemen de mensen de wereld waar in zijn geheel (Brysbaert, 2006). Perceptie is vaak het resultaat van 

interactie tussen verschillende zintuigen (Goldstein, 2007). Zoals eerder werd beschreven, bestaat er 

interactie tussen het reukzintuig en het visuele zintuig en beïnvloeden deze elkaar.   

In dit onderzoek wordt gekeken naar de bijdrage van geur op het vasthouden van visuele aandacht en 

de waardering van visuele stimuli. Het Gestalt principe werkt vanuit meerdere groeperingprincipes. 

Deze principes helpen ons om de dagelijkse visuele percepties te begrijpen (Brysbaert, 2006). Een 

van deze principes is het principe van gelijkenis. Zou dit principe vergeleken worden met de Ambient 

Experience, dan kan verwacht worden dat congruentie tussen beeld, geluid en geur van belang is op 

de beleving. In een onderzoek van Mattila en Wirtz (2001) naar de invloed van geur en muziek op 

consumentengedrag komt naar voren dat wanneer er een overeenkomst, congruentie, bestaat tussen 

geur en muziek, de beoordeling en het gedrag van consumenten wordt verbeterd.  

Daarnaast gaven Seo et al. (2010) ook al aan dat geur de aandacht doet versterken als deze met 

congruente beelden wordt getoond. 
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2.2 Conclusie 

Verschillende onderzoeken tonen aan dat toevoeging van geur effecten teweeg kan brengen. Naast 

invloed te hebben op de gemoedstoestand en het geheugen, heeft geur ook invloed op de waardering 

van stimuli en kan geur bijdragen aan de duur van visuele aandacht.  

Kijkend naar de onderzoeksvragen en hoofdvragen voor dit onderzoek en kijkend naar wat al uit de 

literatuur bekend is, kan gesuggereerd worden dat de geur die toegevoegd wordt congruent zal 

moeten zijn met de video en het geluid om een versterkend effect te hebben op de visuele aandacht 

(Seo et al., 2010; Sakai et al., 2005). Daarbij bestaat wel de kans dat het gebruik van rustgevende 

geuren een verminderd effect heeft op de aandachtsduur (Barcelo, Gale & Hall, 1995). Volgens 

Grabenhorst et al. (2010) kan het gebruik van geur bijdragen aan de waardering van stimuli en dus 

kan verwacht worden dat geur ook een bijdrage levert op de waardering van visuele stimuli.        
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Hoofdstuk 3 | Veldonderzoek | 

             

Geur wordt vaak als een minder belangrijk zintuig gezien (Coren & Ward, 2004), maar speelt vaak een 

grotere rol als gedacht wordt en heeft onder andere invloed op de emoties en beleving (Goel & 

Grasso, 2004; Herz, 2009). Zo blijk geur ook effect te hebben op de vermindering van angst (Saeki & 

Mayumi, 2001). Angst is een van de meest voorkomende problemen voor een operatie (Fayazi et al., 

2011) als ook het ondergaan van een MRI scan (Harris et al., 2004).    

Uit meerdere onderzoeken komt naar voren dat geur verdere effecten teweeg kan brengen. Zo laten 

Seo et al. (2010) zien dat geur de visuele aandacht doet versterken wanneer er congruentie bestaat 

tussen beeld en geur en kan congruentie tussen beeld en geur ook de intensiteit en aangenaamheid 

van een geur verhogen (Sakai et al., 2005). Daarnaast kan geur een versterkend effect hebben op de 

beoordeling van andere stimuli (Grabenhorst et al., 2010; Mattila & Wirtz, 2001).    

In dit kwantitatieve onderzoek wordt centraal gekeken naar de bijdrage die geur heeft op het 

vasthouden van visuele aandacht en de waardering van visuele stimuli. Dit onderzoek voor Philips 

Healthcare naar het reukorgaan in interactie met de andere zintuigen staat echter nog in de 

beginsporen en er zullen na dit onderzoek nog meerdere onderzoeken uitgevoerd dienen te worden 

eer geur eventueel kan worden geïntegreerd in de Ambient Experience.   

Dit onderzoek richt zich op het toetsen van de volgende hoofdvragen: 

In hoeverre draagt geur bij aan het vasthouden van visuele aandacht? 

In hoeverre draagt geur bij aan de waardering van visuele stimuli? 

 

De aanleiding hiervoor is de vraag vanuit Philips Healthcare om het reukzintuig te onderzoeken naar 

toepassingen binnen de Ambient Experience. Dit draagt bij aan de totstandkoming van de volgende 

doelstelling: 

Inzicht verkrijgen in hoeverre geur een bijdrage levert op de duur van visuele aandacht en de 

waarderin van visuele stimuli, ten einde een advies te kunnen opmaken over verdere toepassingen 

van geur binnen de Ambient Experience. Dit om in de toekomst verdere angstreductie te 

bewerkstelligen en de patiënt een verbeterde mate van welzijn hiermee te geven.  

Vanuit de literatuur die bekend is over eerder geur onderzoek, wordt verwacht dat geur, mits 

congruent, een versterkend effect heeft op de visuele aandacht, maar bestaat de kans dat een 

rustgevende geur de visuele aandacht doet verminderen.  

Als gekeken wordt naar de tweede hoofdvraag, dan wordt verwacht dat geur een versterkend effect 

heeft op de waardering.  
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3.2 Methode  

3.2.1 Deelnemers 

Aan dit onderzoek deden 34 proefpersonen mee. Deze proefpersonen hadden een gemiddelde leeftijd 

van 21 jaar en bestonden uit studenten voornamelijk studerende op de Fontys Hogescholen te 

Eindhoven.  

De werving geschiedde door studenten aan te spreken in de kantine, de leergangen, de centrale hal 

en het studielandschap. Voor deelname aan dit onderzoek werden professionaliseringsuren 

uitgedeeld ter beloning. Deze professionaliseringsuren kwamen alleen in aanmerkingvoor studenten 

van de opleiding Toegepaste Psychologie.    

 

3.2.2 Procedure 

Voor dit onderzoek werden twee groepen onderzocht, waaronder de geen geur controle groep en de 

geur experimentele groep. Beide groepen doorliepen dezelfde procedure en kregen dezelfde 

instructie. De proeven hadden een gemiddelde duur van 15 minuten. De verdeling van de groepen 

was N=16 voor de geen geur controle groep en N=18 voor de geur experimentele groep.  

 

De geur voor de geur experimentele groep werd onder 

een button aangebracht (Zie afbeelding 1) en vervolgens 

op de rechterborst van de proefpersoon gespeld. Het 

gebruik van een button dient te voorkomen dat de 

proefpersoon de aromatab ziet en weet dat er iets onder 

zit. Het visuele systeem is namelijk ook betrokken bij het 

identificeren van geuren (Blackwell, 1995). De geen geur 

controle groep werd als eerste getest en kreeg evenals 

de geur experimentele groep een button gespeld op de 

rechterkant van de borst. In het geval van de geen geur 

controle groep dan zonder aromatab.  

Tabel 1 toont een schematische weergave van de onderzoeksopzet.       

 

 

 

 

 

 

 

Afbeelding 1: Button met AromaTab™  
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Tabel 1: Onderzoeksopzet geen geur controle groep en geur experimentele groep 

 

Groep 

 

Button 

 

Video 

 

Geur 

 

Vragenlijst 

Geen geur 

controle 

Ja Ocean, 5.28 min.  Nee Ja 

Geur 

experimentele 

Ja Ocean, 5.28 min. Ja, Lavendel- 

Sandalwood 

Ja 

 

Het testlokaal waarin de proeven werden afgenomen, werd gereserveerd voor het onderzoek zodat de 

testopstelling kon blijven staan en deze steeds constant bleef. Dit testlokaal werd regelmatig 

geventileerd. 

 

3.2.3 Proefverloop 

 

Op het moment dat de proefpersoon binnen liep in het testlokaal, kreeg de proefpersoon de instructie 

van de onderzoeker. Hierin werd verteld dat het de bedoeling is om te kijken naar een video en 

achteraf een vragenlijst in te vullen. Deze video is afkomstig uit de Ambient Experience van Philips 

Healthcare en heeft een duur van 5.28 minuten. Deze duur werd niet verteld aan de proefpersonen.  

Hierna vroeg de onderzoeker of hij de button op de rechter borst mocht opspelden. Voor de geen geur 

controle groep was dit enkel de button, voor de geur experimentele groep zat er een Aromatab onder 

de button. De aromatabs waren afkomstig van het merk Beekley Medical en werden op maat geknipt 

en onder de button geplakt. De button had een diameter van 5,5 centimeter.    

Nadat de button was opgespeld, werd de proefpersoon gevraagd om op een stoel voor het 

beeldscherm te gaan zitten. Dit beeldscherm was gekoppeld aan de laptop, waardoor de onderzoeker 

alles kon besturen. Hierna werd gevraagd om de Sennheiser HD 202 II hoofdtelefoon op te zetten. Dit 

is een gesloten hoofdtelefoon, wat betekent dat geluid van buitenaf niet snel wordt waargenomen. Op 

het moment dat de proefpersoon de hoofdtelefoon ophad, werd de video gestart door de onderzoeker.  

Na de video bleef de proefpersoon zitten en gaf de onderzoeker de proefpersoon een vragenlijst om in 

te vullen. Deze vragenlijst is onder het kopje materialen uitgelegd en terug te vinden in de bijlagen. 

Na het invullen van deze vragenlijst was de proefpersoon klaar met de proef en werd deze bedankt 

voor het deelnemen aan het onderzoek. Indien de proefpersoon een student van de opleiding 

Toegepaste Psychologie was, werd verteld dat met het invullen van een deelnemerslijst een  

professionaliseringsuur kon worden verdiend.  
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3.2.4 Operationalisatie  

Visuele aandacht. Aandacht kan worden gedefinieerd als een selectie maken van stimuli en uitfilteren 

van andere stimuli (Vecera & Luck, 2002). Visuele aandacht kan omschreven worden als een 

mechanisme van het zenuwstelsel dat locaties, kenmerken of objecten binnen het visuele veld naar 

de voorgrond brengt (Bisley, 2011). De mate van visuele aandacht omvat de volgende vier 

indicatoren: afleiding, omgeving, concentratie en interesse. Deze vier indicatoren vormen samen de 

variabele visuele aandacht. Tabel 1 laat de operationalisatie zien van het begrip visuele aandacht, de 

vier indicatoren en de daaruit vloeiende concrete handelingen zoals deze gemeten worden in de 

vragenlijst.  

 

Tabel 1: operationalisatie van visuele aandacht 

 

 

Waardering. Om positieve effecten op de mentale gemoedstoestand te hebben, is het van belang dat 

de geuren waardeert worden (Bensafi et al., 2002). In dit onderzoek gaat het om de waardering van 

de visuele stimuli, de video. De waardering voor visuele stimuli omvat de volgende twee indicatoren: 

aangenaamheid en mooiheid. Deze twee indicatoren vormen samen de variabele ‘waardering’. Tabel 

2 laat de operationalisatie zien van het begrip waardering, de twee indicatoren en de daaruit vloeiende 

concrete handelingen zoals deze gemeten worden in de vragenlijst.    
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Tabel 2: operationalisatie van waardering 

 

 

In het onderstaande kopje materialen wordt een verdere uitleg gegeven over deze twee begrippen, 

hoe deze gescoord worden en welk meetniveau deze hebben. 

 

3.2.5 Materialen 

Om antwoord te geven op de vraagstelling werd in dit onderzoek gebruik gemaakt van een vragenlijst 

als meetinstrument. Waardering en visuele aandacht werden op ordinaal niveau gemeten aan de 

hand van speciaal hiervoor opgestelde vragen. Deze vragenlijst betrof in totaal 10 vragen en een 

kolom voor overige opmerkingen. De vragenlijst bestond uit drie demografische vragen, vier vragen 

over visuele aandacht, twee vragen over waardering en een open vraag waarin naar de reden 

gevraagd werd waarom de video aansprak of juist niet aansprak. 

Onderstaand wordt weergegeven hoe gescoord kon worden op de samengestelde variabelen 

waardering en visuele aandacht. 

Waardering. Werd gescoord aan de hand van twee vragen. 

 Aangenaam: ‘Ik vind de video aangenaam om naar te kijken’ 

 Mooi: ‘Ik vind de video mooi om naar te kijken’ 

Deze twee vragen werden op een hedonische negenpuntsschaal gescoord, welke vaak gebruikt wordt 

om hedonische waardes te meten (Peryam, 1950). Dit is een bipolaire schaal met een neutraal 

midden en vier positieve en vier negatieve antwoordmogelijkheden aan elke kant (Lim, 2011). 

Visuele Aandacht. Werd gescoord aan de hand van vier vragen. 

 Afleiding: ‘Ik werd regelmatig afgeleid’ 

 Interesse: ‘Ik vind de video interessant’  

 Concentratie: ‘Ik heb tijdens de video geconcentreerd gekeken’ 

 Omgeving: ‘Ik heb niets gemerkt van mijn omgeving’ 
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Deze vier vragen bundelen samen de variabele visuele aandacht en werden gescoord op een 

vijfpunts Likert schaal. Deze schaal wordt gewoonlijk gebruikt als het meten van de houding van de 

proefpersoon, waarbij een aantal antwoordmogelijkheden bestaan over een vraag of uitspraak 

(Cohen, Manion & Morrison, 2000). Hier bestonden vijf antwoordmogelijkheden die van 1= Helemaal 

mee oneens tot 5= helemaal mee eens liepen.   

 

3.3 Resultaten 

De groepen waren enigszins gelijk verdeeld, waarbij de geen geur controle groep N=16 en de geur 

experimentele groep N=18.  

Alvorens het beginnen van de analyses werd een Cronbach’s alfa uitgevoerd over de vragen 

behorende de variabele ‘visuele aandacht’ en de vragen behorende de ‘waardering’. De schaal voor 

‘Waardering’ liet een alfa waarde zien van 0.77. Dit is een positieve alfa en duidt op een betrouwbare 

schaal. De schaal voor ‘visuele aandacht’ liet een negatieve alfa van -0.24 zien. Om een betrouwbare 

schaal te krijgen werd de vraag die de negatieve alfa beïnvloedde er uit gehaald. Dit was de vraag ‘ik 

werd regelmatig afgeleid’. Na het weghalen van deze vraag werd de Cronbach’s alfa opnieuw 

berekend. Deze keer liet het een positieve alfa van 0.73 zien.  

Bij de uitvoer van de analyses werden geen missende waarden gevonden. Er zijn in totaal drie 

analysemethoden gebruikt voor de totstandkoming van de resultaten. Deze hebben betrekking op de 

toetsing van verschillen tussen de groepen en de scores op de variabelen ‘waardering’ en ‘visuele 

aandacht’. Hiervoor werd de Mann- Whitney U toets gebruikt. Ten tweede werden de antwoorden op 

de open vraag in de vragenlijst door middel van een frequentietabel verkregen. Als laatste werd er met 

een aanvullende analyse gekeken naar een eventuele samenhang tussen de twee variabelen ‘visuele 

aandacht’ en ‘waardering’. Dit aan de hand van een Spearman’s Rho.   

 

3.3.1 Resultaten Mann- Whitney U toetsen 

Gezien de samengestelde variabelen ‘waardering’ en ‘visuele aandacht’ op ordinaal meetniveau zijn, 

werd gekozen voor een Mann- Whitney U toets. Hiermee werd onderzocht of er een verschil bestond 

tussen de scores op de samengestelde variabelen en de geen geur controle groep en de geur 

experimentele groep.   

 

Visuele aandacht Een Mann- Whitney U toets liet zien dat de ‘visuele aandacht’ van de geen 

geur controle groep (Mean Rank= 19.8, N=16) geen significant verschil liet 

zien ten opzichte van de geur experimentele groep (Mean Rank= 15.4, N= 

18), U=106.500, p=.182, two-tailed.  
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Waardering Een Mann- Whitney U toets liet zien dat de ‘waardering’ van de geen geur 

controle groep (Mean rank= 17.9, N=16) geen significant verschil liet zien ten 

opzichte van de geur experimentele groep (Mean Rank= 17.2, N= 18), 

U=138.000, p=.83, two-tailed.  

 

3.3.2 Resultaten frequentietabel 

Naast de variabelen ‘waardering’ en ’visuele aandacht’ werd in een open vraag gevraagd naar de 

reden waarom de proefpersoon de video aansprak/ niet aansprak. Deze open vraag ‘waarom spreekt 

deze video u aan/ niet aan?’ werd door middel van een frequentietabel geanalyseerd. Tabel 1 geeft 

deze frequentietabel weer. 

Tabel 1: Frequentietabel ‘waarom spreekt deze video u aan/ niet aan?’ voor de geen geur controle groep en de geur 

experimentele groep. 

 

Gegeven redenen 

 

Geen Geur controle groep 

 

Geur experimentele groep 

Rustgevend 11 8 

Mooi 9 9 

Saai/ eentonig 1 4 

Hobby/ Interesse 5 8 

Slaperig 2 0 

 

Deze open vraag werd als vaakst beantwoord met de reden dat de video rustgevend is (N=19; geen 

geur controle groep =11, geur experimentele groep =8) en mooi is (N=18; geen geur controle groep 

=9, geur experimentele groep =9) is. De video sprak de proefpersonen ook aan vanwege de interesse 

en hobby (N=13; geen geur controle groep =5, geur experimentele groep =8).  

Volgens een aantal proefpersonen werd de video saai of eentonig (N=5; geen geur controle groep =1, 

geur experimentele groep =4) en werden er enkelen slaperig van (N=2; geen geur controle groep =2, 

geur experimentele groep =0).  
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3.3.3 Resultaten Spearman’s Rho 

Als aanvullende analyse werd een correlatie uitgevoerd tussen de variabelen ‘waardering’ en ‘visuele 

aandacht’. Gezien het ordinale meetniveau van de variabelen, werd dit aan de hand van de 

Spearman’s Rho gedaan.  

Geen geur controle groep De Spearman’s Rho liet zien dat er geen correlatie bestaat tussen de 

variabelen ‘waardering’ en ’visuele aandacht’ bij de geen geur controle 

groep, r= .24, p= .39, two- tailed, N= 16.  

Geur experimentele groep Verder liet de Spearman’s Rho zien dat er geen correlatie bestaat 

tussen de variabelen ‘waardering’ en ’visuele aandacht’ bij de geur 

experimentele groep, r= .25, p> .32, two- tailed, N= 18.  

 

3.4 Discussie 

3.4.1 Conclusie 

 

In dit onderzoek werd onderzocht of geur een bijdrage kon leveren op de visuele aandacht en de 

waardering van visuele stimuli. De resultaten wijzen uit dat er geen significant verschil bestaat tussen 

de geen geur controle groep en de geur experimentele groep in de waardering van visuele stimuli en 

de duur van visuele aandacht. Daarnaast bestaat er geen samenhang tussen waardering en visuele 

aandacht. Dit houdt dus in dat in dit onderzoek geur geen bijdrage leverde op de duur van visuele 

aandacht en ook geen bijdrage leverde op de waardering voor visuele stimuli. Deze resultaten komen 

niet overeen met eerdere bevindingen uit andere onderzoeken. Onderstaand zijn mogelijke 

verklaringen gegeven voor de bevindingen uit dit onderzoek.  

 

3.4.2 Discussie 

 

Uit onderzoek komt naar voren dat er verschillen bestaan in waarneming tussen het rechter- en linker 

neusgat. Zatorre en Jones- Goodman (1990) gaven aan dat discriminatie van geur het beste was 

wanneer deze via het rechter neusgat werden toegediend. Daarnaast lieten Broman, Olsson en 

Nordin (2001) zien dat geurtoediening via het rechter neusgat beter als vertrouwd werd gewaardeerd, 

dan toediening via het linkerneusgat. Om deze reden werd de button met daaronder de aromatab aan 

de rechterkant van de borst gespeld. Hoewel hiermee rekening gehouden werd, is de vraag of de geur 

voldoende werd waargenomen of dat de concentratie van de geur te sterk fluctueerde. 

Geurwaarneming heeft te maken met de geur concentratie en aangenomen wordt dat een minder 

intense geur gevoelig is voor gewenning (Livermore & Hummel, 2004). Het is in verder 

vervolgonderzoek aan te raden om de geur toediening middels een aromatab nogmaals goed te 

testen.  
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Daarnaast varieert aangenaamheid met de concentratie van een geur (Henion, 1971) en hoewel 

geuren positieve effecten teweeg kunnen brengen, kan een te hoge geur concentratie een 

onaangename werking hebben (Moskowitz & Gerbers, 1974). Sommige proefpersonen gaven aan dat 

de geur prikkelend werkte en dat dit onaangenaam was en anderen gaven aan geen geur geroken te 

hebben tijdens de video. Dit zou een verklaring kunnen zijn voor het feit dat er geen significant 

verschil te vinden is tussen de geen geur controle groep en de geur experimentele groep.  

Al eerder werd genoemd dat blootstelling aan aangename en rustgevende geuren de aandacht kan 

doen verminderen (Barcelo et al., 1995). De resultaten lieten geen significant verschil zien in de duur 

van visuele aandacht bij de geen geur controle groep en de geur experimentele groep. In dit 

onderzoek werd geen aantoonbaar bewijs geleverd dat de lavendel geur werd waargenomen en de 

aandacht deed verminderen.  

Er werd alleen op hand van een vragenlijst data verzameld en de resultaten zijn afhankelijk van dit 

ene meetinstrument. De meest betekenisvolle data van onderzoek naar geur kan worden verkregen 

uit een combinatie van fysiologische en psychologische meetmethoden. Zoals ook al eerder 

aangegeven gebeurt de waarneming van geur vaak op een onbewust niveau (Coren et al., 2004) en 

hebben fysiologische meetmethoden het voordeel dat ze fysiologische reacties op de aanwezigheid 

van geuren kunnen meten. Om echter betekenisvol te zijn moeten ze worden gecorreleerd met 

psychologische meetmethoden (Herz, 2009).  

Gezien in dit onderzoek het aantal proefpersonen 34 was, is het voor vervolgonderzoek aan te raden 

een langere periode van data verzameling te nemen en naar een hoger aantal proefpersonen te 

streven. Met een hoger aantal proefpersonen stijgt de betrouwbaarheid en validiteit en kunnen ook 

uitspraken over eventuele sekseverschillen gedaan worden. Uit onderzoek is namelijk gebleken dat op 

het gebied van geurwaarneming en beleving sekseverschillen bestaan. Zo lieten Chen & Dalton (Chen 

& Dalton, 2005) zien dat vrouwen emotioneler op geur reageerden dan mannen. 

Uit de antwoorden gegeven op de open vraag, kwam veelvuldig naar voren dat de video als 

rustgevend en mooi werd beoordeeld. Voor vervolgonderzoek is het aan te bevelen om naast een 

hoger aantal proefpersonen ook nog een of meerdere video’s op te nemen in de proef. Zo kan 

nagegaan worden of minder interessante video’s eenzelfde resultaat hebben als de video die gebruikt 

is in dit onderzoek. Een aantal proefpersonen gaf ook aan de video mooi te vinden, maar op een 

gegeven moment eentonig te vinden. Doordat de video eentonig werd volgens sommige 

proefpersonen, werd het lastiger de aandacht erbij te houden en vond er afleiding plaats.  

Naast het gebruik van meerdere video’s kan het ook van belang zijn een tweede geur te gebruiken. 

Dit was oorspronkelijk eerst ook de bedoeling in dit onderzoek, maar door een te korte periode van 

data verzameling was dit niet mogelijk. Elmes en Lorig (2008) geven tevens ook aan dat het gebruik 

van een geur controle groep als derde groep het onderzoek kan doen versterken. Deze geur moet dan 

net zo opvallend zijn als de geur die gebruikt wordt in de experimentele groep, maar mag niet dezelfde 

specifieke eigenschappen hebben als de geur gebruikt in de experimentele groep.  
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Uit consumenten onderzoek komt naar voren dat de gemoedstoestand waarin iemand verkeert ook 

invloed kan hebben op het gedrag en waardering. Zo kan bij de waardering van films de 

gemoedstoestand mee spelen in de beoordeling van een film (Winoto & Tang, 2010). Gezien geur 

effect kan hebben op de gemoedstoestand (Herz, 2009) is het misschien ook zinvol om in een 

vervolgonderzoek meer aandacht te besteden aan de gemoedstoestand van de proefpersoon voor en 

na de proef.  

 

De Ambient Experience werd in het theoretische kader al benaderd aan de hand van de Gestalt 

theorie. Conform de Gestalt theorie zou de Ambient Experience als geheel waargenomen worden en 

zou congruentie tussen de verschillende zintuigen van belang zijn op de beleving. Als ook in eerder 

onderzoek is aangetoond, is congruentie tussen beeld en geur ook van invloed op de aandachtsduur 

en kan dit ook de intensiteit en aangenaamheid van een geur doen toenemen (Sakai et al., 2005). 

Daarnaast gaven Mattila en Wirtz (2001) ook al aan dat congruentie tussen geur en geluid een 

versterkend effect heeft op het consumentengedrag en de beoordeling. In dit onderzoek is niet 

gekeken naar enige vorm van congruentie en kunnen er aan de hand van de resultaten geen 

uitspraken hierover gedaan worden.  

 

3.4.3 Aanbevelingen voor vervolgonderzoek 

Dit onderzoek kon, in tegenstelling met eerdere onderzoeken naar geur, geen effecten van geur op de 

visuele aandacht en de waardering voor visuele stimuli aantonen. Er zal dus verder vervolg onderzoek 

gedaan dienen te worden. Samenvattend voor vervolgonderzoek is het belangrijk de manier van 

geurtoediening nog eens te onderzoeken en dit, naast psychologische meetmethoden, aan te vullen 

met fysiologische meetmethoden. Naast de variabelen visuele aandacht en waardering is het ook 

belangrijk vragen over de gemoedstoestand mee te nemen in de vragenlijst. Ook hier heeft een 

fysiologische meetmethode baat bij. Daarnaast is het van belang om meer proefpersonen in een 

vervolgonderzoek te werven. Zo kunnen ook meerdere geuren en video’s onderzocht worden. Als 

laatste is het aan te raden verder onderzoek te doen naar congruentie tussen de zintuigen. Zo kan de 

Ambient Experience ook verder aan de hand van de Gestalt theorie verder onderzocht worden en 

kunnen hierover verdere uitspraken gedaan worden.  

Om geur te integreren in de Ambient Experience zullen er dus nog meerdere onderzoeken moeten 

worden uitgevoerd.  
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Bijlage I Analyseplan 

Stap 1 

Alvorens de gegevens in SPSS worden bewerkt, zullen ze eerst in een codeboek worden opgeslagen. 

Indien dit correct gebeurt is, zullen de gegevens in SPSS worden ingevoerd.  

Hierna zullen van alle variabelen de frequenties worden uitgedraaid om zo na te gaan of de gegevens 

correct zijn opgeslagen. Op deze manier kan dan ook gekeken worden of er geen missing values zijn. 

Gezien de variabele ‘groep’ steeds als laatste werd ingevuld door de onderzoeker, komt deze ook als 

laatste variabele in de datamatrix te staan. Dit codeboek is tevens als bijlage bijgevoegd.  

Het uitdraaien van frequenties in SPSS wordt aan de hand van de volgende stappen gedaan: 

Analyze -> Descriptive Statics -> Frequencies.  

  

Stap 2 

Door het berekenen van zaken als de mediaan, de modus, het gemiddelde, de scheefheid en de 

spreiding kan worden nagegaan of deze aan de voorwaarde voldoen die aan de statistische analyse 

gesteld worden.  

Via Analyze -> Descriptive Statics -> Frequencies kunnen vervolgens de punten worden aangevinkt 

die van belang zijn voor de statistische analyse. Voor de statistische analyse voor dit onderzoek is het 

van belang dat de groepen normaal verdeeld zijn en dat er gekeken wordt naar de scheefheid. 

Ook zal gekeken worden naar de modus op de gegeven antwoorden van de vragen. Het kan namelijk 

zo zijn dat een getal opmerkelijk vaak voorkomt, wat kan betekenen dat de vraag onduidelijk voor de 

proefpersoon is gesteld.  

 

Stap 3 

In dit onderzoek zijn twee schalen opgesteld uit de items van de vragenlijst. Deze schalen vormen de 

samengestelde variabelen ‘visuele aandacht’ en ‘waardering’. Deze twee variabelen bestaan uit de 

volgende vragen.  

 

Visuele aandacht, omvat:  Afleiding;  ’ik werd regelmatig afgeleid’ 

Interesse;  ‘ik vind de video interessant’ 

Concentratie;  ‘ik heb tijdens de video geconcentreerd  

              gekeken’ 
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Omgeving;   ‘ik heb niets gemerkt van mijn omgeving’ 

     

Waardering, omvat:  Aangenaamheid;  ‘ik vind de video aangenaam om naar te 

           kijken’ 

    Mooiheid;   ‘ik vind de video mooi om naar te kijken’

  

Om na te gaan of de items in bovenstaande samengestelde variabelen een betrouwbare schaal 

vormen, zal een Cronbach’s alfa worden uitgevoerd. Vormen ze geen betrouwbare schaal, dan zal 

gekeken worden naar het item die deze negatieve alfa beïnvloed. Een schaal is betrouwbaar als deze 

een alfa waarde van 0.70 of hoger heeft.  

 

Om de Cronbach’s alfa te berekenen worden de volgende stappen in SPSS gedaan: 

Analyze -> Scale -> Reliability Analysis 

Als beide schalen voldoende betrouwbaar zijn, worden aan de hand van de volgende stappen in 

SPSS de variabelen tot twee samengestelde variabelen gemaakt: Transform -> Compute Variable. 

Voor ‘visuele aandacht’ is de formule: (interessant+concentratie+omgeving)/3 

 

Voor ‘waardering’ is de formule: (aangenaam+mooi)/2 

  

Stap 4 

In dit onderzoek wordt hoofdzakelijk gekeken naar een verschil tussen twee groepen, de geen geur 

controle groep en de geur experimentele groep. Gezien de variabelen ‘visuele aandacht’ en 

‘waardering’ zich op ordinaal meetniveau bevinden zal dit aan de hand van een Mann- Whitney U 

toets getoetst worden.  

Deze toetsen worden berekend aan de hand van de volgende stappen in SPSS: Analyze -> 

Nonparametric tests -> 2 Independent Samples. Hierna wordt de ‘Mann- Whitney U’ aangevinkt en 

worden de variabelen in de betreffende kolommen gesleept. De samengestelde variabelen komen in 

de kolom ‘test variable list’ en de variabele groep komt in de kolom ‘grouping variable’.  

Deze toets wordt twee keer uitgevoerd, een keer voor de variabele ‘visuele aandacht’ en de tweede 

keer voor de variabele ‘waardering’. 

Voor dit onderzoek wordt gekozen om een significantie niveau te nemen van p<.10. Wanneer het 

significantie niveau hoger is dan p=.10 betekent dit dat er geen significant verschil gevonden is.  
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De open vraag ‘waarom sprak de video u aan/ niet aan?’ uit de vragenlijst wordt aan de hand van een 

frequentietabel geanalyseerd. Daarmee wordt gekeken naar de gegeven antwoorden en de 

frequenties daarvan.  

 

Stap 5 

Als aanvullende analyse zal nog gekeken worden naar een samenhang tussen de variabele 

‘waardering’ en de variabele ‘visuele aandacht’. Deze wordt aan de hand van een Spearman’s Rho 

berekend.  

Als eerste wordt de variabele ‘groep’ gesplitst in de geen geur controle groep en in de geur 

exerimentele groep. Data -> Split File -> Organize Output by Groups.  

Hierna wordt via Analyze -> Correlate -> Bivariate -> Spearman, de Spearman’s Rho berekend.  

Wanneer de Spearman’s Rho waarde dicht bij de -1 of +1 ligt, kan gesproken worden van een 

samenhang. Ligt deze dichtbij de 0, dan is er nauwelijks of geen correlatie.  
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Bijlage II Begrippenlijst 

A: 

Adaptatie: Proces waarbij receptorcellen minder gevoelig worden naarmate de stimulus langer 

aanhoudt.  

 

Ambient Experience: Een door Philips Healthcare speciaal ontworpen product om in te spelen op de 

gemoedstoestand van de patiënt en daarmee angstreductie te bewerkstelligen en daarnaast bijdraagt 

aan een verbeterde werkstroom bij het personeel. 

 

Amygdala: Amandelvormige kern van neuronen welke een belangrijke rol bij de ervaring en 

uitdrukking van emoties en emotionele herinneringen inneemt.  

 

Aromatherapie: Therapeutische vorm door gebruik van oliën verkregen uit aromatische planten voor 

medische doeleinden.  

B: 

Bulbus olfactorius: Deel van het olfactorische systeem dat betrokken is bij het waarnemen van geuren.  

C: 

Cerebrale cortex: Dunne grijze massa die de grote hersenen, het cerebrum, bedekt. Is voor een groot 

deel verantwoordelijk voor het denken en waarnemen.   

 

Congruentie: Overeenkomst.  

G: 

Gestalt: Gestalt is van oorsprong een Duits woord en is een stroming in de psychologie die van 

mening is dat het geheel meer is dan de som der delen. 

H: 

Hedonische waarde: Een waarde die iets zegt over de aangenaamheid van stimuli als bijvoorbeeld 

geur. 

 

Hippocampus: Onderdeel van het limbische systeem dat een rol speelt bij langdurige herinneringen.  

L: 

Limbische systeem: Deel van de hersenen dat betrokken is bij emoties en herinneringen.  
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N: 

Neuron: Een gespecialiseerde cel in het ontvangen, verwerken en naar andere cellen vervoeren van 

informatie.  

O: 

Olfactorisch epitheel: Deel van het olfactorische systeem dat betrokken is bij het herkennen van 

geuren.  

 

Olfactorisch systeem: Systeem verantwoordelijk voor de reukwaarneming.  

 

Olfactorische zenuw: Oftewel de reukzenuw, is verantwoordelijk voor het vermogen om te kunnen 

ruiken.  

 

Orbi frontale cortex: Een gebied aan de prefrontale cortex, betrokken bij het maken van besluiten.  

P: 

Perceptie: Proces van bewerken en betekenis geven aan inkomende sensorische patronen.  

 

Piriforme cortex: Een deel van de hersenen dat betrokken is bij het herkennen van geur.  

 

Proust fenomeen: fenomeen waarbij Marcel Proust een koekje in de thee dipt en hem terugbrengt 

naar zijn jeugd. 

R: 

Receptoren: Gespecialiseerde neuronen van een zintuig waarbij activering plaats vindt door een 

stimulus.  

S:.    

 

Synaps: Kleine spleet waarlangs de communicatie van neuronen plaatsvindt.  

T: 

Transductie: Omzetting van stimulus informatie in een zenuwimpuls.  

V: 

Visuele aandacht: Het mechanisme van het zenuwstelsel om bepaalde gebieden, objecten of 

kenmerken te benadrukken binnen het visuele systeem. 
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Bijlage III Vragenlijst 

U hebt zojuist een video gezien, nu volgen eerst een aantal algemene vragen en dan een aantal 

vragen over de video die u gezien heeft. 

1) Wat is uw geslacht? (Omcirkel het juiste antwoord) Man   Vrouw     

 

2) Wat is uw leeftijd?     …….  jaar 

 

3) Welke opleiding volgt u op dit moment? 

………………………………….………………………….……………… 

 

4) Ik vind de video aangenaam om naar te kijken   

Uiterst 

onaangenaam 
   Neutraal    

Uiterst 

aangenaam 

-4 -3 -2 -1 0 1 2 3 4 

O O O O O O O O O 

 

5) Ik vind de video mooi om naar te kijken 

Uiterst 

lelijk 

   Neutraal    
Uiterst 

mooi 

-4 -3 -2 -1 0 1 2 3 4 

O O O O O O O O O 

 

6) Ik werd regelmatig afgeleid 

Helemaal 

mee 

oneens 

   

Helemaal 

mee 

eens 

O O O O O 

 

Ga naar de volgende pagina a.u.b. 
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7) Ik vind de video interessant 

Helemaal 

mee 

oneens 

   

Helemaal 

mee 

eens 

O O O O O 

 

8) Ik heb tijdens de video geconcentreerd gekeken 

Helemaal 

mee 

oneens 

   

Helemaal 

mee 

eens 

O O O O O 

 

9) Ik heb niets gemerkt van mijn omgeving 

Helemaal 

mee 

oneens 

   

Helemaal 

mee 

eens 

O O O O O 

     

 

10) Waarom spreekt deze video u aan/ niet aan? 

………………………………………………………………………………………………………………………

…………………………………………………….…………………………………………………………………

………………………………………………………………………………………………………….…………… 

Overige opmerkingen:  

Indien u nog een opmerking heeft, mag u deze op de stippellijn invullen. 

………………………………………………………………………………………………………………………

…………………………………………………….…………………………………………………………………

………………………………………………………………………………………………………….……………   

 

Hartelijk bedankt voor het deelnemen aan dit onderzoek!
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Bijlage IV Ethiek 

Vanuit het boek Ethiek in de psychologie van Rothfusz (2010) worden een aantal basisprincipes van 

psychologisch onderzoek beschreven. Deze hebben betrekking op de autonomie, het niet schaden 

van de proefpersonen en privacy . De proefpersoon wordt in zake autonomie vrij gelaten of hij/zij mee 

wil doen aan het onderzoek en heeft de keuze om op elk moment te stoppen met het onderzoek. Het 

onderzoek zal er op gericht zijn zowel psychisch als fysiek geen schade toe te richten. In zake privacy 

zullen gegevens van proefpersonen anoniem verwerkt worden en zal er vertrouwelijk met de 

onderzoeksdata omgegaan worden. 

De proefpersoon is zoals eerder beschreven vrij in keuze om deel te nemen aan het onderzoek. De 

proefpersonen voor dit onderzoek zullen voornamelijk studenten studerende te Fontys Hogescholen 

Eindhoven zijn. Voor het deelnemen aan dit onderzoek zal er een beloningssysteem bestaan in de 

vorm van studieloopbaan uren.  

 

De proefpersoon zal geïnformeerd worden over het onderzoek, het doel, de risico’s en de aard van 

het onderzoek (Rothfusz, 2010). Wel dusdanig dat de validiteit en betrouwbaarheid van de 

uiteindelijke resultaten niet afhankelijk zijn van de gegeven informatie.  
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Bijlage V Codeboek 

Name Label Values Measure 

Geslacht Wat is uw geslacht? 1=Man 

2=Vrouw 

Nominal 

Leeftijd Wat is uw leeftijd?  Scale 

Opleiding Welke opleiding volgt u 

op dit moment? 

1=Toegepaste psychologie 

2= Overig 

Ordinal 

Aangenaam Ik vind de video 

aangenaam om naar te 

kijken. 

-4 t/m +4 

 

Ordinal 

Mooi Ik vind de video mooi 

om naar te kijken. 

-4 t/m + 4 

 

Ordinal 

Afleiding Ik werd regelmatig 

afgeleid. 

1= Helemaal mee oneens 

t/m 5= Helemaal mee eens 

Ordinal 

Interessant Ik vind de video 

interessant. 

1= Helemaal mee oneens 

t/m 5= Helemaal mee eens 

Ordinal 

Concentratie Ik heb tijdens de video 

geconcentreerd 

gekeken. 

1= Helemaal mee oneens 

t/m 5= Helemaal mee eens 

Ordinal 

Omgeving Ik heb niets gemerkt 

van mijn omgeving. 

1= Helemaal mee oneens 

t/m 5= Helemaal mee eens 

Ordinal 

Groep (Dit is geen vraag in de 

vragenlijst, 

onderzoeker vult deze 

in ) 

0= Geen geur 

1= Geur  

 

Nominal 
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Bijlage 5.6 Authenticiteitverklaring  
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Bijlage VII Resultaten Output SPSS 

 

Cronbach’s alfa  

 

Cronbach’s alfa voor de variabele ‘waardering’ 

Case Processing Summary 

 N % 

Cases Valid 34 100.0 

Excluded
a
 0 .0 

Total 34 100.0 

a. Listwise deletion based on all variables in the 

procedure. 

 

Reliability Statistics 

Cronbach's 

Alpha N of Items 

.774 2 

 

Cronbach’s alfa voor de variabele ‘visuele aandacht’; met het item ‘afleiding’ 

Case Processing Summary 

 N % 

Cases Valid 34 100.0 

Excluded
a
 0 .0 

Total 34 100.0 
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Case Processing Summary 

 N % 

Cases Valid 34 100.0 

Excluded
a
 0 .0 

Total 34 100.0 

a. Listwise deletion based on all variables in the 

procedure. 

 

Reliability Statistics 

Cronbach's 

Alpha
a
 N of Items 

-.241 4 

a. The value is negative due to 

a negative average covariance 

among items. This violates 

reliability model assumptions. 

You may want to check item 

codings. 

 

Cronbach’s alfa voor de variabele ‘visuele aandacht’ zonder het item ‘afleiding’ 

Case Processing Summary 

 N % 

Cases Valid 34 100.0 

Excluded
a
 0 .0 

Total 34 100.0 
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Case Processing Summary 

 N % 

Cases Valid 34 100.0 

Excluded
a
 0 .0 

Total 34 100.0 

a. Listwise deletion based on all variables in the 

procedure. 

 

Reliability Statistics 

Cronbach's 

Alpha N of Items 

.073 3 

 

Mann- Whitney U toetsen 

Mann- Whitney U toets voor de variabele ‘waardering’ 

Ranks 

 Groep N Mean Rank Sum of Ranks 

Waardering Geen geur 16 17.88 286.00 

Geur 18 17.17 309.00 

Total 34   
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Test Statistics
b
 

 Waardering 

Mann-Whitney U 138.000 

Wilcoxon W 309.000 

Z -.213 

Asymp. Sig. (2-tailed) .831 

Exact Sig. [2*(1-tailed Sig.)] .851
a
 

a. Not corrected for ties. 

b. Grouping Variable: Groep 

 

Mann- Whitney U toets voor de variabele ‘visuele aandacht’ 

Ranks 

 Groep N Mean Rank Sum of Ranks 

Visuele_aandacht Geen geur 16 19.84 317.50 

Geur 18 15.42 277.50 

Total 34   
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Test Statistics
b
 

 Visuele_aandacht 

Mann-Whitney U 106.500 

Wilcoxon W 277.500 

Z -1.336 

Asymp. Sig. (2-tailed) .182 

Exact Sig. [2*(1-tailed Sig.)] .198
a
 

a. Not corrected for ties. 

b. Grouping Variable: Groep 

 

Spearman’s Rho 

Spearman’s Rho voor de geen geur controle groep 

Correlations
a
 

 Waardering Visuele_aandacht 

Spearman's rho Waardering Correlation Coefficient 1.000 .231 

Sig. (2-tailed) . .389 

N 16 16 

Visuele_aandacht Correlation Coefficient .231 1.000 

Sig. (2-tailed) .389 . 

N 16 16 

a. Groep = Geen geur 

 

Spearman’s Rho voor de geur experimentele groep 



Pagina | - 46 -  

 

 

Correlations
a
 

 Waardering Visuele_aandacht 

Spearman's rho Waardering Correlation Coefficient 1.000 .251 

Sig. (2-tailed) . .315 

N 18 18 

Visuele_aandacht Correlation Coefficient .251 1.000 

Sig. (2-tailed) .315 . 

N 18 18 

a. Groep = Geur 
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Bijlage VIII Frequentietabel 

 

 

Respondent Rustgevend Mooi Saai/eento
nig 

Hobby/Interess
e 

Slaperig Afwisselen
d 

1 X X     
2 X      
3 X    X  
4    X   
5 X X     
6      X 
7  X    X 
8 X X  X   
9    X X   
10 X X     
11 X X X     
12 X X     
13 X X     
14    X   
15 X X     
16 X      
17 X  X    
18    X   
19 X      
20   X X   
21 X   X   
22 X      
23 X X     
24  X     
25 X      
26 X      
27  X X    
28  X  X   
29  X     
30    X   
31  X  X   
32  X X    
33 X X  X   
34  X  X   
Totaal 11 GG, 8 G  9 GG, 9 G 1 GG, 4 G 5 GG, 8 G 2 GG 2 GG 


